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Microsoft Office applications are utilized by millions of people each day. With this type of
usage, the amount of problems that may be encountered is limitless. Countless errors are
often the result of users being unaware of how to perform a specific task with Microsoft
Office. This chapter focuses not on usage issues or problems that result from a lack of
training, but instead concentrates on problems that go beyond what is expected of the typi-
cal user, such as how to recover corrupted Office files.

Instead of attempting the impossible and indexing every Office error, this chapter
focuses on the tools at your disposal for diagnosing MS Office problems. After examin-
ing the many available tools, the chapter then turns to detailing the most common Office
application problems, along with their related solutions.

Office Troubleshooting Tools

There are several troubleshooting tools available for Microsoft Office that often go unno-
ticed. When a user experiences an application failure or corruption in an Office file, your
job is to get the user back to productivity as soon as possible. Many of these tools allow
you to do just that.

While many of the tools in this section show you ways to repair Microsoft Office, don’t
forget about System Restore (see Chapter 5) as an option. With System Restore, you
can roll back the user’s XP system to an earlier point in time before the application cor-
ruption occurred.

Application Recovery

In pre-XP Office versions, a hung Office application meant that the user had to either
terminate the program using Task Manager or reboot the computer. Either way, the
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possibility of corruption in the open Office document existed. Oftentimes, these files can
be saved by Document Recovery, which is covered shortly. However, if you want a
greater guarantee that a document will be recovered when an Office application stops
responding, Application Recovery is the tool for you.

When an Office application stops responding, Application Recovery forces the hung
application to fail and then restart. By Application Recovery initiating the failure, Office’s
Document Recovery feature can save a recovery version of the file, which will be avail-
able the next time the Office application starts.

When Office stops responding, follow these steps to recover documents opened in
the failed application.

1. Click Start > All Programs > Microsoft Office Tools > Microsoft Office
Application Recovery.

2. In the Microsoft Office Application Recovery dialog box, click the hung
Office application to recover and then click the Recover Application button.

3. When recovery completes, the recovered documents are displayed in the
Document Recovery task pane. From there, you can select the needed docu-
ment and then save it.

Knowledge of this tool alone could save several Office documents. When Office
stops responding, you often immediately either terminate the application using Task
Manager or even go as far as rebooting the system. In any instance of a hung Office
application, Application Recovery should be the first step taken in recovering a failed
Office document. Using Task Manager or rebooting the system should always be your
last resort.

Automatic Recovery

Beginning with Office 2000, the Office application was installed using Microsoft Soft-
ware Installation (MSI) packages. One of the primary reasons for organizations deploy-
ing applications with the use of MSI files is that they can be programmed to have the
ability to “self-heal.” This means that if a user accidentally deleted a file needed by the
application, or if a file was overwritten by an older version, the application could auto-
matically repair itself.

Sometimes users that have used Office for years are suddenly surprised when
prompted for the Office installation CD when they try to open Outlook. This is a typical
example of an application file becoming corrupted, being recognized by the application,
and automatically repaired.

The ability to self-heal in Office is known as Automatic Recovery. With this feature,
if Office was installed from a network share, recovery will occur transparent to the user
as long as the share is accessible. Otherwise, the installation CD will be needed to
recover the damaged file. What Automatic Recovery means to you is fewer calls for sup-
port. Automatic Recovery will save you time even when dealing with home users who
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have become adept at following instructions given to them by their computer. If the com-
puter says, “Put in the Office installation CD,” the user more often than not will obey the
command. The problem is fixed, and the user didn’t even realize that a problem ever
existed!

Like any automatic tool, Automatic Recovery is not perfect. After all, that’s why air-
planes have manual overrides. If a hydraulic system fails, a pilot can manually take con-
trol of the airplane by shutting down the automatic system. Sometimes Office application
problems exist that are not automatically detected and corrected by Automatic Recovery.
When this occurs, you can manually perform a “Detect and Repair,” which is your way
to manually take control of Office troubleshooting when Automatic Recovery fails.

Detect and Repair

Detect and Repair is a tool that is found in the Help menu of every Office application. By
default, Office automatically attempts to repair a damaged installation using Application
Recovery. When Application Recovery does not do the job and you suspect a problem
with a particular Office application, it can be corrected with Detect and Repair.

To start the Detect and Repair process, follow these steps.

1. Open any Office application.
2. Click the Help menu and then select Detect and Repair.

As shown in Figure 6-1, the Detect and Repair dialog box presents you with two
repair options.

* Restore my shortcuts while repairing—The default option, it repairs Office
and recovers user custom settings (shortcuts, recently accessed files, user
name).

* Discard my customized settings and restore default settings—Custom user
settings are discarded and replaced with default settings (requires you to
reconfigure user’s Office settings after the repair completes, such as Out-
look information).

Detect and Repair ed B

'Detect and Repair,.." will automatically find and Fix errars in all Office files,

During this process you may be asked to provide the installation source andfor exit open
applications.,

¥ Restore my shorkouks while repairing
[ Discard my customized settings and restore default settings

Cancel |

Figure 6-1. Repairing an Office installation with Detect and Repair
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Once you choose the repair option in the Detect and Repair dialog box, follow these
steps to complete the repair process.

1. Click the Start button, and Office scans and replaces any corrupt or missing
files as well as reverts Office-related Registry settings to the installation
defaults.

2. If prompted, insert the Office installation CD or browse to the path of the
Office installation files.

3. When the repair completes, click OK.
When Office is corrupted to the point that an application cannot be opened in order

to perform Detect and Repair, you need to repair the installation using Office Setup. Use
of this method is covered later in this chapter.

In order for Detect and Repair to successfully repair an Office application, all installed
Office applications should be at the same version and service pack level; otherwise, the
repair process may fail. For example, if you are running Word and PowerPoint XP but
also have Outlook 2000 installed, you likely will not be able to repair the older Outlook
version and if trouble is encountered, you should instead install Outlook XP.

Document Recovery

Document Recovery has been substantially improved with Office XP. In previous Office
versions, a lost document resulting from a user’s workstation locking up could quickly
add up to an hour or longer of troubleshooting. With Office XP, the application itself
does the troubleshooting for you. After a system crash, the next time you start the Office
application, such as Word, your previous file versions that were saved by the application
will appear in the Document Recovery task pane in the application window. Figure 6-2
shows Document Recovery displaying two versions of the Word file CorruptMe.doc.
With Document Recovery, the user just selects the needed version of the file, and it
opens. Once the file opens, the user can then save it, overwriting the file’s original ver-
sion, or save it with a new filename.

If any recovered files were not viewed by the user, the user is asked by Office how to
treat the unexamined files when the Office application is closed or when the user clicks
the Close button in the Document Recovery pane. When prompted, the user has the
choice to view the files the next time the Office application is opened or to have the files
removed. These options are shown in Figure 6-3.

Open and Repair

When Word or Excel files are opened, if Office detects corruption in the file, it automati-
cally tries to repair the file. Sometimes corrupted files are not noticed by Office, and you
may wish to manually initiate a document-level repair. While some files may be corrupted
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Figure 6-2. Recovering Word documents with Document Recovery

Microsoft ¥Word : :-__- 2=

been opened. ‘Would vou like to view these files the next time you start Word?
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Figure 6-3. Document Recovery prompt

to a point where repair is not possible, for others, however, Open and Repair provides you

with a way to recover valuable information.
To use the Open and Repair feature to repair
these steps.

1. Open the Office application (Word or Exc

2. Click the File menu and then select Open.

a corrupted Word or Excel file, follow

el).

3. Browse to and select the corrupted file, then click the Open drop-down
menu (see Figure 6-4) and select Open and Repair.
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4. If a Word file is being repaired, it automatically opens in Word. If you are
repairing an Excel file, select the Repair option in the Repair dialog box.

Once you select Repair, the document opens with at least some, if not all, of its orig-
inal content intact.

Look in: I@ My Documents j - - & X O ~ Tools +
My Fictures
;ﬁ;—,i My Wirtual Machines
Histary: MV Webs
Pinnacle Studio
Techiet
BrokenSpreadsheet, x|s
Iy Documents
&
Deskbop
*]
Favatites
@
¥ .
== File name: - o
v o} Open |~
Iy Metwork I J rl
Places

Files of type: IAII Microsoft Excel Files (%, * sy * xle; * . htm; * himl; j Cpen

COpen Read-Only
Open as Copy

| Open and Rg:air.M

Figure 6-4. Selecting to Open and Repair an Excel spreadsheet

One other means of recovering data in a corrupted file is with the use of the recover

command line utility. Since recover is not just limited to Office files, it is described in
Chapter 7, Disk Subsystems.

Setup

When Office is inaccessible and the problem has not been corrected by Application

Recovery, you can repair the Office installation with Setup. This section shows you the
two primary ways to repair Office using Setup.
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From Add/Remove Programs
This method is easy for any user to follow, since the user does not need to know the
physical location of the Office Setup files. Of course, this assumes that the Setup files
exist in the original location from where they were installed, whether on a network
or CD.

To repair an Office installation from Add/Remove Programs, follow these steps.

1. From the Control Panel, double-click the Add/Remove Programs icon.
. Select the Microsoft Office installation and then click the Change button.

. Select the Repair Office option and click the Next button.

A W

. To repair the installation, select Detect and Repair. If you want to preserve
user shortcuts, select the Restore my Start Menu Shortcuts checkbox and
then click Install (see Figure 6-5).

5. Once the repair process completes, you will be prompted that Office Setup
has repaired your installation. Click OK.

6. Click Close to close the Add/Remove Programs dialog box.

iz Microsoft Dffice XP Setup

Microsoft Office XP Professional with FrontPage

Reinstall or Repair Office installation

Setup can automatically find and fix errors in wour Microsoft Office %P installation, or vou
can use Setup to reinstall Office just as it was installed originally.

" Reinstall Cffice
¥ Detect and Repair errors in my Office installation

[V Restare my Start Menu Shortcuts

During this process wau might be asked to close open programs andfor provide the CDar
nekwaork location you used to install originally,

Help | < Back

Figure 6-5. Repairing an Office installation with Office Setup

Cancel
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From the Setup CD or the Network
This repair method requires knowledge of the location of the Office Setup files, and for
this method to work, you must know the location of both the Setup executable and the
installation .msi file. There are several switches available for the Office setup com-
mand, but only one pertains to repairing an Office installation.

The syntax for using setup to repair an Office installation is:

setup /f<options> <.msi file path>

The .msi file path parameter points to the installation’s associated .msi file. For
a default Office XP Professional installation, the file is named ProPlus.msi. Table 6-1
describes the options associated with the /£ switch.

Table 6-1. setup /f Command Options

Option  Use
a Causes all Office Setup files to be reinstalled, regardless of the checksum value or
version.

Causes corrupted or missing Setup files to be reinstalled.

a Causes missing files or files with a version other than the Setup version to be rein-
stalled.

e Causes missing files or files with a version equal to or less than the Setup version
to be reinstalled.

m Causes all Office-related system Registry values to be rewritten.

o Causes missing files or files with a version older than the Office Setup version to
be reinstalled.

o) Causes missing files to be reinstalled.

s Causes all shortcuts to be reinstalled, with existing shortcuts being overwritten.

u Causes all user-specific Office Registry values to be overwritten.

v Causes Office Setup to run from the Setup package specified (.msi file) and

recache it as the local installation package.

There are two predominant methods for running setup with the /£ switch, which
are as follows:

* To repair an Office installation: setup /focums ProPlus.msi

¢ To reinstall Office: setup /fecum ProPlus.msi

Each of these examples assumes that the Office XP Professional Setup is used and
that the installation .msi file resides in the same directory as the Setup executable. Now

that you have seen the troubleshooting tools at your disposal, the remainder of this chap-
ter focuses on specific Office troubleshooting scenarios.
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Don't forget about booting the system into Safe Mode at startup as a viable trouble-
shooting test. If a document or presentation file does not open normally but opens
when the system is booted into Safe Mode, check for faulty or outdated drivers on the
system. If the document or presentation has sound integrated into it, a likely place to
check is a nonexistent or improper driver for the sound card.

Troubleshooting Office Setup

Office Setup is generally very reliable, installing well both through local installations and
from software installation packages via a group policy object (GPO). However, Setup is
not perfect, and there are several errors that may contribute to its failure. As with trouble-
shooting other failures, start with the obvious first, eliminating what’s right, and then
move on to more granular troubleshooting.

Eliminating the Obvious

Table 6-2 lists some quick checks you can perform that allow you to quickly narrow your
list of potential causes for the problem.

Table 6-2. Office Setup Failure Quick Checks

Problem Solution
Setup If hard disk activity is indicated by the system’s hard disk LED, Setup
running slow may just be running slower than you anticipate. The solution in this sce-

nario is to apply patience to the problem.

Virus Viruses can cause countless problems and certainly don’t spare program
installations. Verify that the system’s antivirus software has the most
current virus signatures and that a virus scan was run recently.

Dirty or If the CD drive’s LED remains on, and Setup is not progressing, try
damaged CD removing, cleaning, and then reinserting the installation CD. If
prompted that a file was not copied, click the Retry button.

User permissions If the installation can be run by an Administrator but cannot be run
when the user is logged on with his or her own account, then the user
does not have adequate permissions to install the program.

Corrupt profile Corrupt user profiles can cause a whole assortment of problems with
Microsoft Office, and Setup is not excluded. To see if this is the prob-
lem, log off the user, and rename the user’s profile folder (located by
default in C:\Documents and Settings\<username>). Then have the user
log back on. The user will get the default system profile. If installation
runs successfully, the profile was the problem. Once installation is com-
plete, you can make the user very happy by copying the contents of his
original Favorites and My Documents folders in his corrupted profile to
his new profile.
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If after each of these checks Setup still does not respond, first pat the user on the
back and let him know that his system is in overall good shape, and then take a look at
the Setup log files.

Using the Setup Log Files

At this point, you have found out quite a bit about what is running right on the system
but have still not found the problem. The next ideal place to pinpoint the source of the
problem is to look in the Setup log files. Often, they will lead you right to the encoun-
tered problem. When Setup is executed, three log files are generated:

* Setup.exe log—saved as “Office XP <Version> Setup(####).txt”

* Windows Installer Office Installation log—saved as “Office XP <Version>
Setup(####)_Task(####).txt”

* Windows Installer System Files Update log—saved as “Office XP
<Version> Setup(####)_Task(####).txt”

Normally, the System Files Update installation is not required, so it is likely that you
will see only two pertinent log files. For example, for an Office XP Professional with
FrontPage installation, these two log files would be created in the user’s Temp folder
(Documents and Settings\<username>\Local Settings\Temp): “Office XP Professional
with FrontPage Setup(0001).txt” and “Office XP Professional with FrontPage
Setup(0001)_Task(0001).txt”.

The generic Setup log file normally does not contain much useful information, since
it outlines the install options selected. When an installation problem is encountered, the
Task logs are the best places to check. In Figure 6-6, an Office Installation Task log is

[B! Office %P Professional with FrontPage Setup(0001)_Task{D001 -0l x|
File Edt Format Wiew Help

: Foldercreate(Folder=C:\pocuments and settingshall Usershapplication Data_J
: Actionstart(Mame=InstallFiles,Description=Copying new files,Template=Cop

. Copying new files

: ProgressTotal(Total=227561552, Type=0, Byteequivalent=1)

: setTargetFolder (Folder=C:Nprogram FilesMicrosoft officerofficelo™1033%)

: sersourcerolder CFolder=1%\FILESYPFILES"MSCOFFICENOFFICELON1033Y | FilesyProdg

B hangemedta(Medtavo lumelabe |=0FFICELD, MediaPrompt=F |ease 1nsert the disk

FileCopy(Sourcaname=UsSPANNTN, XML, SourceCahkey=uspanntn. EGEC. AF40AAFE_S18
hPar‘t2——1?05295839 HashParti= ?444411? HashPartd=15400450,0
gr am F1195\M1crosoft Off1ce\off1celO\lOBB\USPANNTN #*ML;  To he dnstalled;
ile 'uspanntn.EGBC.AF4OAAFS_BlS?_4EOC_AZEE_3440?SBSEE?C' is compressed

Kl | W

Figure 6-6. Office Installation Windows Installer log
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shown. This log file was examined after an Office installation failed while it was begin-
ning to copy files. Note that the highlighted message indicates that the installation no
longer believes that the Setup CD is in the CD-ROM drive. It was later determined that
the CD-ROM drive had failed. The lesson learned here is that with the help of the Setup
logs, you can quickly get pointed toward the direction of the actual problem.

When reading log files to find the source of a failure, don’t read them like a story, start-
ing at the top and working your way to the bottom. Since the logs are written chrono-
logically, start at the bottom to read the most recent information and then work your
way to the top. Information regarding the Setup failure is most likely going to be
recorded at the end of the log file. If an error code is displayed when Setup terminated,
you can find information related to the error by searching the log file for the error code.
Events immediately before the code should contain useful information on the problem.

Access Errors and Solutions

When Access databases become corrupted, you have several methods to consider when
attempting to recover their data. If the data is not very dynamic, the fastest approach is
likely to restore the database from the most recent backup. On the other hand, if quite a
bit of new data exists for the database, or if no recent backup exists, you have no alterna-
tive but to try to recover its data.

In your moment of misery, having to recover a damaged database under pressure,
you can at least take satisfaction in the fact the Access is a very polite application, typi-
cally telling you the following before it crashes: “Microsoft Access has encountered a
problem and needs to close. We are sorry for the inconvenience.” To many, this is proba-
bly much more than a mere inconvenience, but at least Access is not laughing at you.

When an error is encountered, normally Access stops responding, and you may or
may not receive an error message as a result. Regardless of the error you receive, you
should first determine whether the problem is related to the Access application or to the
database itself. The easiest way to do this is to restart Access and then open another data-
base. If the problem is only associated with the single database, then you have a cor-
rupted database to deal with, which requires a little more work. On the other hand, if the
problem is happening with any database that is opened, consider it your lucky day, since
all it means is that the Access installation is damaged. To repair a damaged Access instal-
lation, here are your alternatives.

* Open Access and use the Detect and Repair tool.
* Repair the Access installation by running Setup as was described earlier.

* Remove and then completely reinstall Office.
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In addition to completing hanging the Access application, corrupted databases often
exhibit the following behavior.

* Objects in the database cannot be accessed.

* Some records display #Deleted.

Most Access database corruption problems stem from its architecture. As a
Microsoft Jet database, it does not use transaction logs, such as are used by enterprise-
class databases such as SQL, Exchange, and Oracle.

The main reason for the lack of reliability stems from the fact that when logging is
used, database writes can be temporarily stored in a transaction log file and later commit-
ted to the database during a period of less database activity. Without the transaction log,
having multiple clients read and write data to and from the same database can lead to
data corruption. For local databases that are only accessed by a single client, nonlogged
databases have proven to be very reliable and thus still are used today for databases such
as the DHCP and WINS databases on Windows servers.

If you lost your spot while reading this page, it is probably because the last para-
graph put you to sleep. Let’s not spend any more time discussing transaction logging and
get to troubleshooting. When dealing with recovering a corrupted database, here are your
alternatives to fix it.

* Use the Compact and Repair tool.

* Manually repair the corrupted portion of the database.

The next two sections address these recovery techniques.

Before attempting any recovery method, always make a backup copy of a corrupted
database. This way, if one repair method fails, you still have another version of the
original database to work with.

Using the Compact and Repair Tool

The quickest means to fix corruption in any Jet database is to compact it, and this rule is
no exception with Access databases. When dealing with a corrupted database, you must
first verify that it no longer has an .1db file associated with it.

Consider the .1db file to be the “hall monitor” for the database. For example, if a user
named Juan was currently accessing the “water fountain” record, and another user
attempted to write to the same record, Access would check the .1db file and see that it is
Juan’s turn, and would politely tell the other user to wait a moment.

With the .1db issue in mind, here is the general procedure for compacting a database.
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1. Make a backup copy of the database.

2. Use Windows Explorer to locate the database file, and delete the associated
1db version of the file, if it exists.

3. Open Access to compact and repair the database.

For example, if you had an Access database named FixMe.mdb, its .1db partner
would be named FixMe.ldb. Before compacting the database, you would delete
FixMe.ldb.

With the preliminary steps out of the way, you can now get to the specifics of using
Compact and Repair. To use this utility, follow these steps:

1. Open Access.

2. Click the Tools menu, select Database Utilities, and then click Compact and
Repair Database.

3. In the Database to Compact From window, browse to and select the cor-
rupted database file. Then click the Compact button.

4. In the Compact Database Into window, enter a new name for the compacted
database and click Save.

5. Try to open the compacted database in Access. If the database corruption is

no longer present, rename the compact file to the original database name.

Compact and Repair is generally the most reliable means to eliminate database cor-
ruption. If this tool was not successful, avoid playing the lottery today, and instead
attempt one of the methods described next.

Manually Repairing a Database

At this point, you are at your last resort in dealing with the corrupted database. This sec-
tion assumes that the database can at least be opened in Access and that a portion of the
database is accessible. If not, your other option is to restore from the most recent backup
version of the database file.

The manual repair process differs with the type of problem that needs to be fixed. In
this section, you will see how to manually repair these three areas of database corruption:

* Problems running reports
¢ Problems with macros or modules

¢ Problems with a database table

Steps to resolve each of these three problem types are listed in the next three sections.
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Problems Running Reports
If the problem is associated with a particular report or with one of its controls, the easiest
resolution is to take these steps.
1. Delete the report.
. Restore an earlier version of the database to an alternate location.
. In Access, open the corrupted database.

. Click the File menu, select Get External Data, and then click Import.

[ VS I )

. In the Import dialog box, locate and select the restored good database, and
then click the Import button.

6. Click the Reports tab in the Import Objects dialog box. Then click the
Options button.

7. Select a report and then choose the options needed to ensure that all aspects
of the imported report apply to the corrupted database (selecting all options
for a particular report is the safest).

8. When finished selecting the report import options (see Figure 6-7),
click OK.

9. You should now see the report listed in the corrupted database.

10. Save the database as a new version. If the report functions properly, you
have succeeded.

Import Objects

Tahles l Queries ] Forms ~Reports lPages l Macros ] Modules l
Resource Schedule
Resources by Type
Cancel
Select Al
Deselect Al

Import Import Tables Import Queries
v Relationships {+ Definition and Data * fAs Queries
¥ Menus and Toolbars ™ Definition Only " As Tahles

[ Import/Export Specs

Figure 6-7. Selecting report import options
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At this point, your database should be back to normal. If not, as a final alternative,
you could start from scratch and re-create the corrupted report.

Problems with Macros or Modules
When the problem is with a macro or module associated with the database, you again
have the option of deleting the corrupted macro and importing an earlier version of it
from a restored version of the database. These are the steps to perform this process.
1. Delete the macro.
. Restore an earlier version of the database to an alternate location.
. In Access, open the corrupted database.

2
3
4. Click the File menu, select Get External Data, and then click Import.
5

. In the Import dialog box, locate and select the restored good database, and
then click the Import button.

6. Click the Macros tab in the Import Objects dialog box. Then click the
Options button.

7. Select a macro and then choose the options needed to ensure that all aspects
of the imported macro apply to the corrupted database (selecting all options
for a particular report is the safest).

8. When finished selecting the macro import options, click OK.
9. You should now see the macro listed in the corrupted database.
10. Save the corrupted database as a new version. If the macro runs normally,

your work is finished.

If importing the macro from a backup version of the database failed, or if a backup is
not available, then also consider performing one of these actions.

* Create a new macro, and then copy the contents of the corrupted macro to
the new one.

¢ Re-create a new macro from scratch.

Of course, re-creating anything from scratch is never the answer anyone is looking
for, but it may be the only answer. Even if importing fails, remember that as long as some
backup version exists for the original macro, then you have at the very least a baseline
for creating the new macro.

Problems with a Database Table
If a particular database table is not acting as it should, or database corruption resulted
from the creation of a new table, you may be able to repair the individual table to restore
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the database to working order. This is the general procedure for repairing a database con-
taining a corrupted table.

1. Open the database in Access and export the corrupted table to an ASCII
(delimited text) file.
2. Delete any relationships associated with the table.

3. Delete the table.

N

. Save the database, and then save a copy of the database to an alternate loca-
tion (backup).

. Compact and repair the database.
. Re-create the table as well as any relationships that it had.

. Open the exported table in Notepad.

[CIEEN e Y )

. Remove any out-of-place data from the file, and then resave the file. Note
the data that had to be removed, since you will have to manually reenter it
later.

9. Import the data from the text file to the new table.
10. Reenter any records that were removed from the exported text file.
11. Save the database.
With this approach, you have systematically removed the corrupt table and replaced

it with a new version. Exporting and then reimporting the table’s data allowed you to
remove the table corruption without losing any of its data.

Excel Errors and Solutions

As with Access databases, Excel spreadsheets sometimes fall victim to data corruption.
In addition to recovering from corruption, Excel-related troubleshooting often revolves
around locating the source of an errant calculation. This section addresses two common
Excel troubleshooting and fault resolution methods:

* Repairing corrupted spreadsheets

* Isolating and correcting formula errors

Repairing Corrupted Spreadsheets

When a user cannot open a spreadsheet, there are three paths that you can take to resolve
the problem.
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* Restore from backup.
* Repair the spreadsheet.

» Export the contents of the spreadsheet, and then manually re-create it.

Damaged spreadsheets can be repaired using the Excel Open and Repair feature.
When you cannot access a spreadsheet, this should be your first course of action in the
repair process. To repair the spreadsheet, you need to use the Office Open and Repair
feature that was documented earlier in this chapter. With Excel, Open and Repair offers
more options than when used in Word, allowing you the choice of repairing a damaged
spreadsheet or extracting the data from the spreadsheet. When using Open and Repair,
always try the Repair option first. If that option fails, then try to extract the data from the
spreadsheet.

To repair a damaged spreadsheet, follow these steps:

1. Open Excel.

2. Click the File menu and then select Open.

3. Browse to and select the corrupted file, then click the Open drop-down
menu, and select Open and Repair.

4. When prompted, click the Repair button (see Figure 6-8).

Microsoft Excel =]

Excel can perform checks while opening the workbook and attempt to repair any corruption it detects, or extrack

i‘: just the data (formulas and values) From the warkbook,

» Click Repair if wou wank to recover as much of wour work as possible.
#» Click Extract Data if Excel was previously unable ko repair the workbook,

Repair I Extrack Daka | Cancel |

Figure 6-8. Excel Open and Repair options

The repaired spreadsheet should now open in Excel. If it did not open, your final
choice is to try to extract the data from the spreadsheet. To do this, follow these steps.

1. Open Excel.

2. Click the File menu and then select Open.

3. Browse to and select the corrupted file, then click the Open drop-down
menu, and select Open and Repair.

4. When prompted, click the Extract Data button.



Wolf.C06.gxd

5/28/03 3:10 PM Page 190 $

190 Chapter 6 Office XP

5. You now have two choices (see Figure 6-9), which are to either convert
irrecoverable formulas to values or recover as many formulas as possible. If
the formulas contained in the spreadsheet are of the most importance, select
Recover Formulas; otherwise, select Convert to Values.

6. Excel should now open with some data recovered from the spreadsheet. At
this time you will also be prompted with a hyperlink to the repair log file,
as shown in Figure 6-10. Click the hyperlink to view the log file, and then
close the Repair dialog box.

Unfortunately, when extracting data, you are only left with a plain spreadsheet con-
taining the extracted data. Any graphics or formatting that was used in the original
spreadsheet is lost.

Now that you have seen the ways to recover from corruption in Excel spreadsheets,
next you will see how to overcome errors when using and manipulating formulas.

This workbaaok mayw contain Formulas with references that Excel cannok recaver, Do you want Excel to convert these
formulas to values, or recover as much of the Formulas as possible?

Canvert ko Yalues | Recover Formulas I

Figure 6-9. Open and Repair Extract Data options

Repairs to ‘ExpenseRpt.xls* ! 2l

the file ko make these changes permanent.

& Microsoft Excel extracted only the data from 'ExpenseRpt.xls'. Sawve

Excel attempted ko recover vour formulas and values, but some data may have been lost or
corrupted.

Click to view log File listing repairs:  C:\DOCUME~ 14 CWOLF~1 . COMILOCAL S~1\ Tempirepair01232 03.kxt

Figure 6-10. Repair log prompt
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Isolating and Resolving Formula Errors

There are several available auditing tools that allow you to diagnose the cause of a prob-
lematic formula. Invalid formulas are generally easy to spot, since an error code is dis-
played in the formula’s cell. The common Excel error codes are described in Table 6-3.

Table 6-3. Excel Cell Error Codes
Error Related Problem(s)

A * Column is not wide enough.
* Time or date has a negative value.
#DIV/0! * Number is divided by zero.

¢ Formula references a blank cell.

#N/A * Value referenced by the formula is not available.
* Data is missing.

* Argument in an array formula is used that does not have the same amount of
rows and columns as the range that contains the array formula.

#NAME? » Text used in the formula is unrecognized.
* Name is misspelled.
* Another sheet is referenced that is not in quotes.
* Colon in a range reference is missing.

* Function that is part of the Analysis Toolpak (add-in) is used without the add-
in loaded.

#NULL! * Incorrect range operator is used.

* Ranges specified in a range operator do not intersect.

#NUM! e Invalid numeric values are used in a formula or function.

#REF! » Formula or function references an invalid cell.
¢ Cell referenced by other formulas was deleted.

 Link exists to a system or program that is not available.

#VALUE! Incorrect argument or operand used (number expected, letter provided).

Sometimes, the source of an error is very obvious. For example, a column may be
too small to represent a numerical value, or you may quickly spot a typographical error
in a formula. Other times, however, finding the source of an error may be a bit more
challenging. When you are stumped as to the source of an error, Excel provides the fol-
lowing tools to assist you:

* Trace Precedents—Shows formulas referenced by the selected formula

* Trace Dependents—Shows formulas that require the output of the selected
formula
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» Trace Error—Allows you to step through cell relationships to find the
source of an error

* Evaluate Formula—Shows the progress of the outcome of a formula as it is
calculated, allowing you to see the point in a formula where the error
begins (like step-by-step confirmation at startup)

Each of these troubleshooting tools can be accessed by clicking the Tools menu and
then selecting Formula Auditing and the desired tool. Each of these tools allows you to
visually detect the source of a formula problem, letting you quickly get to its source.

Outlook Errors and Solutions

Once configured properly, Outlook is generally maintenance free. During the initial con-
figuration or after a reinstallation, Outlook problems are most frequently reported.
Unlike other Office applications, many external factors—such as network configuration,
mail server configuration, and security configuration—can all contribute to the inability
of a user to access his or her mailbox. In this section, you will see how to check for a cor-
rect Outlook configuration and how to diagnose a problem when one is encountered.

Testing Outlook Configuration

Outlook e-mail configuration can be tested during the initial mailbox setup (the first time
Outlook is run) or from within Outlook. You can test the mail configuration during setup
by clicking the Test Account Settings button in the E-mail Accounts dialog box (see Fig-
ure 6-11). You will then see the test results in the Test Account Settings dialog box, as
shown in Figure 6-12. If all tests pass, you will see a green check next to each test. Failed
tests are marked by a red X, and their related error messages are displayed under the
Errors tab.

For accounts that are already created, you can access the mail account test from
within Outlook. To do this, follow these steps.

1. From Outlook, click the Tools menu and select E-mail Accounts.
. Select View or Change Existing E-mail Accounts and click Next.
. Select the mail account to test, and click the Change button.

2
3
4. Now click the Test Account Settings button.
5

. If all tests pass, close the E-mail Accounts dialog box; otherwise, resolve
the configuration problem and then click the Test Account Settings button
to verify that the configuration change resolved the problem.

The account settings test tells you that there is a problem but does not offer any
advice on resolving it. If you’re familiar with the typical department meeting environment,
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Internet E-mail Settings {(POP3)

Each of these settings are required to get your e-mail account working,

User Information

server Information

four Mame: |Clueless Joe

Incaming mail server (POP3):

E-mail Address:  |cjne@unrelisblemail. com

Logon Information

Cukgoing mal server (SMTP):

Test Settings

User Mame: |cjc-e

Password: |********

Iv Remember password

™ Log on using Secure Password
Authentication (SPA)

Test Account Setbings ... |

After filing out the information on this screen, we
recommend you test your account by clicking the button
below. (Requires network connection)

||:-op.unreliab|email.cc-m

|srntp . ureliable.comn

< Back

More Settings ...

Cancel |

Figure 6-11. Testing e-mail account settings

Test Account Settings

Tasks l Etrors l

Congratulations! All kests completed successfully, Click Close o continue,

Tasks | Skatus |
" Establish network connection Completed
" Find oubgaing mail server (SMTR) Completed
\/Find incoming mail server (POP3) Completed
\/Log onko incoming mail server (POP3) Completed
\/Send test e-mail message Completed

Figure 6-12. E-mail account test results

this is not much different from the average employee issuing a complaint but providing no
alternative. If you don’t get upset with your coworkers for acting this way, then don’t get
mad at Outlook either! At least it’s telling you something.

Now that you know a problem exists, you need to identify it in order to correct it.
Table 6-4 lists components to check based on the test that failed.
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Table 6-4. Typical Problems for Failed Mail Setup Tests

Failed Test Possible Problem(s)

Establish network connection * TCP/IP is not installed or is improperly configured.
* An Internet connection is not present.

e TCP/IP is not listed first in the network binding order.

Find outgoing mail server * The wrong server name was provided.

* A name resolution problem exists (DNS, WINS, Hosts,
LMHosts).

Find incoming mail server * The wrong server name was provided.

¢ A name resolution problem exists (DNS, WINS, Hosts,
LMHosts).

Log on to incoming mail server * The wrong account was provided or does not exist.
* The wrong password was used.

* The account was entered wrong (you may need to use
the entire SMTP address: user @domain.com).

Send test e-mail message The mail server requires user authentication to send the
message, and user credentials were not provided. Provide
credentials for the outgoing server by following these
steps.

1. In the E-mail Accounts dialog box, click the More
Settings button.

2. Click the Outgoing Server tab in the Internet E-mail
Settings dialog box.

3. Check the My Outgoing Sever Requires Authentica-
tion box, and then elect to use the same settings as
the incoming server or manually enter the account
information.

As you can see, several different failures can interrupt mail service. Always remem-
ber to start from the top and work to the bottom. So, if both the “Find outgoing...” and
“Find incoming mail server” tests fail, verify that name resolution is working by pinging
the POP and SMTP (or Exchange) servers by fully qualified domain name. If the ping
fails, then try to ping by IP address. If pinging by IP address fails, then you have a net-
work connectivity or TCP/IP configuration (subnet) problem. If the IP address ping
passed, then the problem is with the name resolution used. Name resolution can be fixed
by verifying that the user has the proper name servers listed in her system’s TCP/IP prop-
erties. After correcting any DNS issue, remember to run ipconfig /flushdns on the
user’s system to clear the contents of its DNS resolver cache; otherwise, the problem will
persist.
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Some mail servers may be configured to ignore the Outlook test message, so if all other
tests pass and the “Send test e-mail message” test fails, there may be nothing wrong
with the mail configuration. Save the configuration, and then send a message from the
account to itself. If the mail is sent and received, the account is set up properly.

PowerPoint Errors and Solutions

Corrupted PowerPoint presentations are the most common problem encountered by users
running PowerPoint. When corruption is encountered, the user is presented with one of
the following symptoms or error messages:

e “Part of the file is missing”
» “PowerPoint cannot open the type of file represented by ...”
* “This is not a PowerPoint presentation”
These errors all point directly to the PowerPoint presentation being accessed by the
user, but some error messages may not be as obvious, including:
* General Protection Fault
¢ Illegal instruction
* Invalid page fault
* Low system resources
* Out of memory
As you can see, many PowerPoint presentation errors may be masked as other
errors, which is again why the user interview is so important. If the problem occurred
when a presentation file was being opened, you can try to duplicate the error by having
the user open the same and subsequently different presentation files. If the errors are only
displayed when a particular file is opened, then you can assume that the cause of the
error is file corruption. When this occurs, the easiest solution is often to restore the file
from a known good backup. If a backup does not exist, or if the backup version is cor-
rupted as well, then you will have a little more work to do.
First, you need to determine the cause of the problem before weighing other solu-

tions. To arrive at the cause, ask the user each of the following questions, until you get a
“Yes” answer.

¢ Did the problem occur during or after the time something was added to the
presentation?
* Does the problem occur when a specific file is opened?

* Does the problem occur when any file is opened?
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When the Problem Resulted from a Modification to the Presentation

The type of problem may be the result of the user attempting to copy and paste a new
page or object into the presentation. If the problem only exists when accessing a particu-
lar slide, you have several choices.

* Delete and then manually re-create the slide.
* Copy all slides in the presentation, and paste them into a new presentation.

* Copy portions of the corrupted slide to a new slide, and then delete the cor-
rupted slide.

Regardless of which action you take to resolve the corruption problem, you should
also consider saving the presentation file as a new version, just in case the existing ver-
sion is on the brink of corruption. When an entire presentation file becomes corrupted,
the corrective action involved in resolving the problem is much more detailed than cor-
ruption in a single slide and is discussed next.

When the Problem Resulted from a Specific File Being Opened

Problems associated with a single file are easily identified, since you can quickly open a
different file with the PowerPoint application to verify the limitation of the problem. As
long as all other files open without incident, you are only concerned with repairing a sin-
gle file, as opposed to correcting a corrupt PowerPoint installation.

There are several ways to go about extracting useful data from a corrupt presentation
file, each of which is described in the next three sections. If none of these solutions can
save the corrupted presentation, then your last alternative is to restore an earlier version
of the presentation from the most recent backup.

Open Presentation Version in Temp Folder
AutoRecover versions are saved in the Temp folder located with the user’s profile. By
default, the Temp folder resides in the Documents and Settings\<Username>\Local Set-
tings directory. Presentation files saved in this folder begin with the characters PPT fol-
lowed by four numbers and have the .tmp extension.

The easiest way to locate these files on a user’s XP system is to follow these steps.

1. Click Start and then select Search.

2. Select All Files and Folders.

3. Now click More Advanced Options and select the Search Hidden Files and
Folders checkbox.

4. In the All or Part of the File Name field, enter PPT* . tmp as the search cri-
teria, select to look in the C drive, and then click the Search button.
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5. All autosaved PowerPoint files should now appear in the right pane of the
Search Results window. Click the Date Modified column to sort the files by
date, which should make it easier for you to spot the needed file.

6. Once you locate a file, click its name once, and then click it again. You
should now be able to rename the file. Rename the file anything you want,
but make sure to change its extension to .ppt.

7. Double-click the file to attempt to open it.

Even after you locate the autosaved file, there are no guarantees that PowerPoint can
even open it. If the file opens and its data is intact, your work is finished. Otherwise, you
can either throw in the towel here and restore from backup or attempt one of the next two
methods shown in this section to recover data from the original file.

Extract Corrupted Slides

Another method for recovering data from a corrupted PowerPoint presentation file is to
open a new blank presentation and attempt to extract the slides from the corrupted pres-
entation file. This can be done by performing these steps.

1. Open PowerPoint, click the Insert menu, and then select Slides from Files.

2. In the Slide Finder dialog box, click the Browse button and locate the cor-
rupted file. Then click Open in the Browse window.

3. You should now see the presentation file displayed in the File field and its
slides displayed in the Select Slides portion of the window. If no slides are
displayed, this method will not work for you, and you should move on to
the third method, described in the next section.

4. Click the Select All button to import all slides, or use the Ctrl key and your
mouse to select the slides that you would like to import. If work on the last
slide is the suspected cause of the corruption, then select all slides but the
last. When finished selecting the slides to import, check the Keep Source
Formatting checkbox, and then click the Insert button (see Figure 6-13).

5. With the slides imported into the new presentation, you can now delete the
first slide (which should be blank) and then save the new presentation.

With your extraction operation complete, you can now exhale, especially if you were
working without a safety net and had no available backup to fall back on.

Apply Corrupted Presentation as a Template
If both the first two methods failed, your last hope is to recover the slide master. If the
corrupted presentation was the only file that used an original important master slide
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Slide Finder

Find Presentation l List of Favorites ]

File:  |\=:\Documents and SettingsiChris WolfiMy DocumentsiUnrela  Browse.,.,

Add to Favorites

Select slides: yap ZlO

Treubls ehizedng Teelinlqus

Network
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TZPAP Tl & |

|1. Metwork Troubleshooking tZ Troubleshooting b TCRIIP Tonls
RI 2l
[ Keep source Formatting Insert | Insert all | Close |

Figure 6-13. Importing slides using the Slide Finder dialog box

template, then you can use this method to attempt to recover the master. To do this, fol-
low these steps.

1. Open PowerPoint, click the Format menu, and then select Slide Design.

2. You should now see the Slide Design window displayed on the right side of
the PowerPoint window. At the bottom of the Slide Design window, click
Browse.

3. Browse to and select the corrupted presentation file and then click Apply.

4. The slide master from the corrupted presentation replaces the slide master
for the new presentation.

If you could not recover any potion of the corrupted file, then your last choice is to
turn to your trusty backup and restore the last backed-up version of the file, or you can
kindly instruct the user to start all over, declaring the corrupted presentation file deceased
and alerting the user that it will be given a proper burial.

When the Problem Resulted from Any File Being Opened

If you cannot open any PowerPoint files, then pump your fist in victory because this is
the easiest PowerPoint problem to correct. After all, the worst scenario that you are faced
with when no files can open in PowerPoint is to reinstall Office from scratch.
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When the PowerPoint installation is damaged, you can manually initiate a Detect
and Repair process to correct the problem, or you can rerun Setup to repair the applica-
tion. Regardless of how you perform the repair or reinstallation, the user’s Office appli-
cation will be restored and no presentation data will be lost.

Word Errors and Solutions

Word is arguably the most powerful and certainly the most diverse Office application.
Due to its diversity, however, it is also the most problematic. This is not because of poor
design or even a lack of reliability but because of the fact that so many other Office com-
ponents can be integrated into it, including spreadsheets, graphics, and voice. Some com-
pare the architecture of Word to how newer expensive cars are built. When you buy a
new car with “power everything,” you are buying a lot more items that have the potential
to break. The same can be said of Word, with the only difference being that your
“options” were already chosen for you.

This portion of the chapter is divided into two sections:

* Resolving Problems with the Support.dot Troubleshooting Template

* General Word Troubleshooting

Due to the frequent necessity for support personnel to troubleshoot Word problems,
Microsoft created a troubleshooting template for it. This first part of this section shows

you how to install and use the template. Following the template section, you will then see
how to approach and resolve the most common Word problems.

Resolving Problems with the Support.dot Troubleshooting Template

Sometimes problems can be quickly spotted and resolved, while others are more com-
plex. To aid in solving Word problems, Microsoft has included several macros in the
Support.dot template. There are three macros included with the template, which are
described in Table 6-5.

Table 6-5. Troubleshooting Template Macros

Macro Use

AutoCorrect Backup Allows you to back up the AutoCorrect list on one system and then
use the macro on another system to restore it.

Registry Options Provides an easy means to modify Word Registry settings.

Troubleshoot Utility Provides a means to troubleshoot and repair Word startup problems.

If you performed a complete installation of Microsoft Word, the template is already
installed on the user’s system. If not, you need to manually install the template.
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Installing the Troubleshooting Template
Since the template is not installed by default, odds are that you will have to manually
install it on most systems. For mass deployment, the best choice is to deploy the Office
update using a group policy. Regardless of how you deploy the template, the method for
installing it on a user’s system or test system is still the same.

To install the troubleshooting template, follow these steps.

1. Close Microsoft Word and all Office applications.

2. From the Control Panel, double-click the Add/Remove Programs icon.

3. Select the Microsoft Office installation and then click the Change button.
4. Select Add or Remove Features and click Next.
5

. In the Features to Install field, expand the Microsoft Word for Windows
object and then expand the Wizards and Templates object.

6. Now select the More Templates and Macros icon and select Run All from
My Computer.

7. Finally, click the Update button to revise the Microsoft Word installation.
Once the template is installed, you can put it to use.

Using the Troubleshooting Template

To use the troubleshooting template, you must first open Word in Safe Mode. To do this,
click Start > Run, type winword.exe /a, and press Enter. Once Word has started, fol-
low these steps to open the template.

1. Click the File menu and select Open.

2. In the Open dialog box, click the Files of Type field and select Document
Templates.

3. Now click the Look In field and browse to the following folder: <Office
installation drive>\Program Files\Microsoft Office\Office 10\Macros.

4. You should now see the Support.dot template file. Click the file and then
click Open.

5. If you receive a security warning, click the “Always trust macros from this
source” checkbox and then click Enable Macros.

Once the template has opened, you are ready to troubleshoot.

Using the Troubleshoot Utility
The Troubleshoot Utility is used to solve Word startup problems. This macro accom-
plishes this by allowing you to revert particular files and startup settings to their default
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values. One of the problems with restoring settings to their default values is that any
custom configuration data set up by the user is lost. With this template, only damaged
data is lost. For example, if you thought that the default startup template, Normal.dot,
was the source of the problem, you could test your theory by replacing this file with the
default. If your repair did not help, then you could restore the previous version of the
template, taking the Word installation right back to the point where it was when you first
started troubleshooting.

With this utility, you can systematically replace Word startup files one at a time until
you find which one is bad. At the end, only the problem files will be replaced and all oth-
ers will be in their user-specific configuration. If you're still a little confused about how
and when to use this tool, you must first understand the files that are loaded when Word
starts, which are

1. Data Registry key
2. Normal.dot global template
3. Add-ins and templates

4. COM add-ins

5. Options Registry key

If any of these components are corrupted, Word is not likely to start. When you run
winword.exe /a, none of these files are loaded. If Word starts with the /a switch but
doesn’t start without it, then the problem is definitely in one of the five configuration
files, and you should resolve the problem by running the Troubleshoot Utility. If Word
still does not start with the /a switch, then you should repair the Word installation using
Detect and Repair or by running Office Setup.

Determining the startup file that is the cause of the corruption requires a systematic
approach. The easiest way to find the problem is to disable one startup file at a time until
the problem does not return. To incorporate this process to find a faulty startup file, fol-
low these steps.

1. As was described earlier in this section, start Word in Safe Mode
(winword.exe /a) and open the Support.dot template.

2. In the Support.dot template, click the Troubleshoot Utility button.

IV}

. As shown in Figure 6-14, select Data Registry Key in the Select an Item
field and then click Delete.

. When prompted about the location of the backup Registry key, click OK.
. Click Close to exit the Troubleshoot Utility.
. Close Word.

[N NV RN N

. Start Word normally
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Microsoft Word Troubleshooting Utility E|
Select an kem:
|Data Registry Key j |Delete| Restare | Close |
Description:
During skartup, one of the events that occurs is the loading of the Word -

Data registry kew. IF this reqgistry key is damaged, Word mavy Fail bo skart or
Function propetly,

- Delete will backup then remove the Data reqgistry key, Word will generate
a new Data key with default settings after you exit this session of Word and
launch Word normally without the [fa switch,

If Wword starts and operates correctly after deleting the Data key and then
launching Word normally, vou have resolved the problem. The problem was
a damaged Data registry key, MOTE: ¥ou may need to change a Few -

Figure 6-14. Using the Troubleshoot Utility to repair Word

If Word starts normally, the problem is fixed. If not, you need to restore the old Reg-
istry settings and then check to see if the Normal.dot template is causing the problem.
This involves performing the following steps.

1. Close Word.

2. Run winword.exe /a to start Word in Safe Mode. Then open the
Support.dot template.

3. In the Support.dot template, click the Troubleshoot Utility button.

4. Select Data Registry Key in the Select an Item field and click the Restore
button.

5. When prompted that the Registry key restoration was successful, click OK.

6. Now select Normal.dot Global Template in the Select an Item field and click
Rename. When prompted with the new name for the template, click OK.

7. Click Close to exit the Troubleshoot Utility.

8. Close Word.

9. Start Word normally.

If Word starts normally, your work is now finished; if not, you now know that the
Normal.dot template file is fine, and it’s on to check number 3.

1. Close Word.

2. Run winword.exe /a to start Word in Safe Mode. Then open the
Support.dot template.

3. In the Support.dot template, click the Troubleshoot Utility button.
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. Select Normal.dot Global Template in the Select an Item field and click the

Restore button.

. When prompted that the backup template was copied over the default tem-

plate, click OK.

Now select Word Startup Folder Add-ins in the Select an Item field and click
Rename. When prompted with the new name for the Add-ins, click OK.

Click Close to exit the Troubleshoot Utility.
Close Word.

Start Word normally. If Word does not start, you can conclude that the Add-ins were
not corrupt and can proceed to the fourth check.

1.
2.

Close Word.

Run winword. exe /a to start Word in Safe Mode. Then open the
Support.dot template.

. In the Support.dot template, click the Troubleshoot Utility button.

Select Word Startup Folder Add-ins in the Select an Item field and click the
Restore button.

. When prompted that the Add-ins were restored successfully, click OK.

Now select COM Add-ins Registry Key in the Select an Item field and click
Delete. When prompted that the Registry key has been deleted, click OK.

. Click Close to exit the Troubleshoot Utility.
. Close Word.

Again you need to attempt to start Word normally. If Word does not start, and you
are sure that it would initially start with the /a switch, then there is only one other poten-
tial problem. To rid yourself of this problem, follow these steps.

1.
2.

Close Word.

Run winword. exe /a to start Word in Safe Mode. Then open the
Support.dot template.

. In the Support.dot template, click the Troubleshoot Utility button.

Select COM Add-ins Registry Key in the Select an Item field and click the
Restore button.

. When prompted that the Registry key restoration was successful, click OK.

Now select Options Registry Key in the Select an Item field and click
Delete. When prompted that the Registry key has been deleted, click OK.
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7. Click Close to exit the Troubleshoot Utility.
8. Close Word.

For the last time, start Word normally. You should see that at this point Word starts
without incident. As you have witnessed, not only is this tool terrific in isolating and fix-
ing a Word problem, but it also employs a systematic “textbook” approach to trouble-
shooting.

Using Registry Options
Suppose that a Registry problem has caused Word to stop responding, but you don’t want
to completely delete the Word Registry keys, leaving you with the default settings. If you
want to manually attempt to patch the Word Registry values, you can do so with the Reg-
istry Options tool. Not only does this tool make modifying the Word Registry parameters
easy, but it also explains the purpose of each Registry value to you, making it difficult to
make an editing mistake.

To use this tool, follow these steps.

1. Start Word normally and then open the Support.dot template.

2. In the Support.dot template, click the Registry Options button.

3. Now you can select the option you plan to modify and view a description of
it at the bottom of the Set Registry Options dialog box.

4. If needed, change the data for the option in the Setting field and click
Change (see Figure 6-15).

5. When finished modifying the Word Registry settings, click close and exit
the Registry Options tool.

When you want to quickly modify a user’s custom Word settings, nothing is faster
than the Registry Options tool. The last tool offered by the Support.dot template is Auto-
Correct Backup.

Using AutoCorrect Backup
If you would like to take a user’s custom AutoCorrect settings and apply them to another
user’s profile, then the AutoCorrect Backup utility is the perfect tool for the job. Due to
its limited role, this is the least frequently used of the Support.dot tools, but is nonethe-
less valuable.

To export AutoCorrect settings with this tool, follow these steps.

1. Start Word normally and then open the Support.dot template.
2. In the Support.dot template, click the AutoCorrect Backup button.

3. In the AutoCorrect Utility dialog box, click the Backup button.
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Select a name and location for the backup file in the Save As dialog box

and click Save.

. Click Cancel to close the AutoCorrect Utility dialog box.

Set Registry Options

Word Options ] Equation Editor Options ]

Option:

AukoSave-Path a

Close

Fickure-Path

Startup-Path Change
Tools-Path
ser-Dot-Path Browse. .

workgroup-Dot-Path

Bak-Extension

Do -Extension

DOT-Exkension

MaoFontMRULIsE

SpelingWwayyUnderlineColar j

Setting:

il

| Ci\Documents and SettingsiChris Wolf\My Documents

The default Folder that is used For Word documents.
value in the Setting box. Then choose the Change button,

setting, Choose Documents,

To change dlick on the Browse button, select & folder, and click on OK, or vou can type a new

‘ou can also choose Options From the Tools menu and use the File Locations kab to modify this

Figure 6-15. Modifying Word Registry values with the Registry Options tool

and then follow these steps.

S N ]

|

. Start Word normally and then open the Support.dot template.
. In the Support.dot template, click the AutoCorrect Backup button.
. In the AutoCorrect Utility dialog box, click the Restore button.

. When prompted that this will replace the current AutoCorrect entries,

click Yes.

. When prompted that the restore is complete, click OK.

. Browse to and select the AutoCorrect backup file to import and click Open.
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7. Click Cancel to close the AutoCorrect Utility dialog box.

8. Close the Support.dot template.

Now that you have seen the value of Support.dot, the all-around troubleshooting
tool, let’s look at how to solve other Word problems that cannot be corrected with
Support.dot.

General Word Troubleshooting

For general corruption of the Word application that cannot be fixed with the Trouble-
shoot Utility, don’t forget about using Detect and Repair to correct the application prob-
lem. If a Word document is corrupted and will not open, then try to use the Open and
Repair tool to fix the file; otherwise, you need to restore it from backup.

Since the Word application’s scope extends far beyond the Word application itself,
you may find that the source of a Word problem has little to do with Word. When Word
fails and starts to give up on you, or you receive the error “Microsoft Word has encoun-
tered a problem and needs to close,” you should first close Word and then restart the
application. If the problem does not return once the document is reopened, there is little
troubleshooting that you can do at this point. If the problem returns, look to the faults
and related problems listed in Table 6-6 as your means to resuscitate Word.

Table 6-6. Word Problems and Probable Faults

Problem (Error) Probable Faults and Solutions

Error occurs when printing. * Bad printer driver.

* Download an updated or correct printer driver from the
printer manufacturer. If one does not exist, it’s time to
upgrade the printer.

Error occurs while typing or * Bad video driver.

m(?ving th? mouse (mouse » Download an updated or correct video driver.
Ssrl:;i;Sklps across the * Not enough memory—add RAM.

Error occurs while typing * Corrupt user dictionary.

text into a document. « Corrupt AutoCorrect file.

 Corrupt fonts.

* Corrupt spelling and grammar files.

For problems occurring while the user is typing text, you have to determine which of
four likely faults is the source. Remember that Word checks your work as you’re typing,
so when errors occur at this time, the cause of the problem is usually related to one of the
files used while Word autochecks your work. When these types of errors occur, the easi-
est approach to resolving them is to systematically replace the files involved until the
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problem disappears. In the next four sections, we begin with replacing the dictionary and
finish with replacing the spelling and grammar files.

Replacing Corrupt User Dictionaries
When Word stops responding while the user is editing a document, begin by closing
Word and all other Office programs, and then follow these steps to replace the dictionary.

1.
2.

Click Start and then select Search.

Select All Files and Folders, then scroll down, and select More Advanced
Options.

. Check the Search Hidden Files and Folders box.

. Scroll back up and enter * . dic in the All or Part of the File Name field,

make sure that Local Hard Drives is selected in the Look In field, and then
click Search.

. The search should return a list of Custom.dic files. Locate the file that

resides in the profile folder for the user having the problem, right-click the
file, and select Rename.

. Enter a new name for the file, such as Custombak.dic, and press Enter.

. Restart Word and try to edit the document. If the problem disappears, your

work is finished. If not, the custom dictionary file was not corrupted, so
you can repeat steps 1-5 to find the .dic files. This time, delete the new
Custom.dic file in the user’s profile and rename the backup version back to
Custom.dic.

If replacing the user’s custom dictionary file did not solve the problem, your next
option is to try to replace the AutoCorrect file.

Replacing Corrupt AutoCorrect Files
To replace a user’s AutoCorrect file, close Word and all Office applications, and then fol-
low these steps.

1.
2.

Click Start and then select Search.

Select All Files and Folders, then scroll down, and select More Advanced
Options.

. Check the Search Hidden Files and Folders box.

. Scroll back up and enter * . ac1l in the All or Part of the File Name field,

make sure that Local Hard Drives is selected in the Look In field, and then
click Search.

. The search should return a list of MSO###.acl files (for example,

MSO1033.acl). Locate the file that resides in the profile folder for the user
having the problem, right-click the file, and select Rename.
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6. Enter a new name for the file, such as MSO1033bak.acl, and press Enter.

7. Restart Word and try to edit the document. If the problem disappears, your
work is finished. If not, the AutoCorrect file was not corrupted, so you can
repeat steps 1-5 to find the .acl files. This time, delete the new
MSO###t.acl file in the user’s profile and rename the backup version back
to its original name, such as MSO1033.acl. If you did not try to access the
AutoCorrect Options from the Word Tools menu, a new .acl file might not
have been created. If this is the case, just rename the .bak version of the file
back to its original name.

Some Microsoft documentation states that you should not rename any MSO####.acl
files. This is incorrect. In fact, there is normally only one MSO####.acl file in each
user’s profile, so it is the only .acl file that you would have a choice to rename to
replace a corrupt AutoCorrect file.

Replacing Corrupt Fonts

If the AutoCorrect file was not the source of the Word problem, then your next option is
to assume that the font being used is corrupt and replace it. Unlike the previous two
problems, a corrupt font affects all users running Word on the system, not just a single
user. Fonts are installed on computers and are not unique to users using the computer.
When a font is suspected as the fault, you should first make a list of the fonts used in the
document and then replace the fonts one at a time until the problem disappears. To
replace a corrupt font, follow these steps.

1. Open the Control Panel and double-click the Fonts icon.

2. Find the suspect font, and then drag and drop it onto the Desktop. This
removes it from the installed fonts without deleting it.

3. Open Word. Since the font is no longer installed, it is replaced in the docu-
ment with another font. If the problem is resolved, then run Detect and
Repair to repair the Office installation. The font will be replaced during this
process, and you can delete the instance of the font that appears on the
desktop.

4. If the problem still exists, then reopen the Fonts folder in the Control Panel
and drag the font that was moved to the Desktop back to the Fonts folder.
Next, move another font contained in the document to the Desktop, and
repeat step 3 to see if the problem is resolved.

If replacing the suspected corrupted font did not resolve the problem, your last
option is to replace corrupt spelling or grammar files, since by default they are also
queried while a user is editing a document.
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Replacing Corrupt Spelling and Grammar Files
To replace corrupt spelling and grammar files, follow these steps.

1. Open Word, click the Tools menu, and select Options.
2. Click the Spelling and Grammar tab in the Options dialog box.

3. Now clear the Check Spelling as You Type and Check Grammar as You
Type checkboxes and click OK.

If the problem goes away after you disable the spelling and grammar checking tools,
then you can fix the corruption by running Detect and Repair.

Summary

As you have witnessed, manually diagnosing and repairing Office corruption problems is
a lengthy process. When the problem is associated with a single user, you may want to
simply rename the user’s profile folder. To do this, log the user off, rename the user’s
folder in the Documents and Settings folder, and then have the user log back on. If the
problem disappears, then it was embedded in the user’s profile. To make the user happy,
you can copy his Favorites and My Documents folder contents into his new profile and
copy his Outlook.pst file into his new profile, if e-mail is stored locally. While there is
always a way to identify the exact cause of a problem, it doesn’t always make the most
business sense.

Detect and Repair often allows you to quickly repair Office application problems,
and when document corruption rears its ugly head, don’t forget about the Open and
Repair tools available in Word and Excel. When diagnosing and repairing Office prob-
lems, remember to use the right tool for the job and use the right process when trou-
bleshooting. You cannot go wrong with the systematic “checklist” approach for
eliminating what’s right. Eventually, you will find the fault. When dealing with Office
corruption, always remember to refrain from wanting to flex your troubleshooting mus-
cle when diagnosing a problem. All too often, the 30 minutes of work lost by the user
results in two or more hours of diagnosis and repair. If a backup exists for a corrupted
file, and only noncritical data that can easily be replaced will be lost, use the backup. If
you really want to practice troubleshooting in a non-mission-critical situation, remember
“That’s what friends and family are for!”

A great way to prevent corruption problems with Office documents from ruining
everyone’s day is to educate users to get in the habit of saving documents daily using
the Save As feature instead of simply using Save. For daily versions, the user could use
Save As, then enter the regular name of the file, followed by a hyphen and then the
name of the day. This way, the most work that will ever be lost due to corruption will
be that of a single day.
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